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Chapter 1

Introduction to Userview Builder



Apps

Progressive Web Apps
Various Form Factors

Development

Simple, Visual,
Drag and Drop.

&

Platform

Open, Flexible and
Extensible.

G0
Infrastructure

On-Premise, Containers,
Private / Public / Hybrid
Cloud. App Server,

DB, OS Independent.
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Userview Builder

* Application front-end interface builder.
e Serves as the wrapper for forms, processes, datalists.

e Extensible functionalities through Joget’s plugin
architecture.



Userview Builder

USERVIEW BUILDER Ppurchase Requisition v1: Purchase Requisition (Published)
DESIGN USERVIEW SETTINGS PREVIEW SAVE

B Form Purchase Requisition
g #date EEE, d MMM yyyy# Logout
& Inbox Menu
& Link # Home
B List
Welcome
p Run Process
Run Process
& Universal Inbox

CRUD

2, User Profile

* Userview elements.

I
| Enterprise |  Each element is a plugin.

cruo CRUD

* Drag-and-drop.

Calendar

=
L Chart
® Powered by Joget

Dashboard




Userview Builder

e Sample Userview using the DX Progressive theme

EXPENSES CLAIMS APP

‘?f:ﬁ A AR m # Home > Dashboard
& Dashboard Expenses Claims Dashboard

£22 Reset to default layout
My Expenses y

=) mbtintrs Sl
(=] Approver List +]

Finance List

3000

L Setup Category January 2020 Draft Claimant o 2400
January 2020 Claims 1110.00 Draft Claims Edit
O info +] “ 2000
December 2019 2400.00 Draft December 2019 Draft Claimant -
claims claims Edit c
’}A 1500 4
wl
Travel to UK Draft Travel to UK Draft Claimant —
Edit 2 1000 4
Jake 110.00
Jake HOD 500 |
4 items found, displaying all items. Approve
| | | 4 items found, displaying all items. 0
. | | | Jake December 2019 claims January 2020 Claims
Create A New Expense Claim : Title




Userview Builder

 Sample Userview using the DX X-Admin theme

Expenses Claims App v @ Admin Admin ¥
Dashboard My Inbox Submitted Expenses Setup Category
@& Dashboard
Dashboard
B My Expenses N ERitboat
My Inbox Expenses Claims Dashboard
Submitted Expenses
My Expenses cno My Inbox co Expenses Trend cno
Approved Expenses u
Rejected Expenses n
3000
Closed Expenses n
January 2020 Claims 1110.00 Draft January 2020 Claims Draft Claimant Edit
B Approver List < 2500 2
December 2019 claims 2400.00 Draft December 2019 claims Draft Claimant Edit
B Finance List <
oy 2000
£+ Setup Category Travel to UK Draft Travel to UK Draft Claimant Edit
o 1500
0 info < Jake 110.00 Jake HOD Approve %
D 1110
4 items found, displaying all items 4 items found, displaying all items. © 1000
| | I I I |
Create A New Expense Claim 200
110
o .
Jake December 2019 claims ~ January 2020 Claims
Title




Plugin Types

@ Joget DX

App Builder Components & Supported Plugin Types
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Chapter Review

* General understanding of the Userview Builder and its
functionality.

* General understanding on its elements and its
extensibility capability.
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Chapter 2

Designing Your First Userview



@Joget
Before You Continue

e This chapter serves more or less a recap of what we have
learnt previously in

— Designing your First Process
— Designing your First Form
— Designing your First Datalist
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Create New Userview

Version 1 | Published

Create New Form
[# Forms & Ul FORMS

28 Processes B 1-Submit Request

©& Properties & Export B 2-Approve / Reject Request

B 3-Acknowledge Approved

@ Performance

‘R Logs

Q@ Al Apps

Create New Datalist

LISTS

purchase_requests B3 Request List

urcnas rec SIS
'u'c"a“e_fef uests

purchase_requests

CREATE NEW USERVIEW

USERVIEW DETAILS
ID purchaseRequisitionPortal
Name Purchase Requisition Portal
Description
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Userview Category

e |tems are organized by Category.
 Add 1 new category — Purchase Requisition

e

D v @A ©

!o

& oget USERVIEW BUILDER Ppurchase Requisition v1: Purchase Requisition Portal (Published)
DESIGN USERVIEW

A Form

nme HTML Page

Inbox

Link

List

Run Process

Universal Inbox

» User Profile

SETTINGS PREVIEW

Purchase Requisition Portal
Click to edit

#date.EEE, d MMM yyyy#

Menu

A Home

Welcome

SAVE

+ |
Add Category
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@ Joget

HTML Page As the First Item

When the Userview is loaded, Purchase Requisition Portal

#date EEE, d MMM yyyy#

the first available (and permissible) | wen o

item will be loaded automatically. e

‘ Welcome @) (2)(x

HTML Page is recommended as

the first menu item, to serve as EUEhems Reuininon

the landing page.

It will be automatically added when a new Userview is created.

You may edit as needed by clicking on Properties while hovering
over it.

Reference: http://dev.joget.org/community/display/DX7/HTML+Page
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http://dev.joget.org/community/display/DX7/HTML+Page

@Joget
Run Process Menu

* Run Process enables one to start a process instance from
the Userview.

e Reference:
http://dev.joget.org/community/display/DX7/Run+Process+Menu

17


http://dev.joget.org/community/display/DX7/Run+Process+Menu

Add Run Process Into Userview

* Drag-n-drop Run Process into Purchase Requisition category.

©icget USERVIEW BUILDER Ppurchase Requisition v1: Purchase Requisition Portal (Published)
DESIGN USERVIEW SETTINGS PREVIEW SAVE

B Fom Purchase Requisition Portal

w0 #date EEE, d MMM yyyy#

& Inbox Menu +)
& JJEIRE A Home
BB List
Welcome
I P Run Process
& Universal Inbox 7
Purchase Requisition B)@)B)O)x)

&, User Profile

cruo CRUD

» Run Process

g Calendar

L Chart

@ | Bastiboard Powered by Joget
ashboar




Integrate Run Process Into Userview

e Set the appropriate label.

e Select Purchase Request Process in Process.

USERVIEW BUILDER Ppurchase Requisition v1: Purchase Requisition Portal
DESIGN USERVIEW SETTINGS PREVIEW SAVE

) Undo | C' Redo  /# Advanc

| B Form Purchase Requisition Portal
[ HTML Page okt
ol lnbox #date.EEE, d MMM yyyy# Logout
Menu o2 Aut
| & Link
m List # Home Edit Run Process > Redirection > Advanced > |
P Run Process
Weloome Edit Run Process @
& Universal Inbox
Id BA6BD1DB1F184754AD3251ASEB6FFB22
&, User Profile Purchase Requisit
| Custom ID
cruo CRUD Label * Submit New Request
Process * Purchase Request Process (purchaseReq... £I¥

’ L« Chart

I @ Dashboard
Run process without

it il 7

| & Datalist Inbox A confirmation screen?

| & Import Menu Show in popup
| dialog?

=N




Custom ID for Userview Menu

* Assign a Custom ID. It is used to identify the link’s name.

e Custom ID is optional but it must be unique when set.

Edit Run Process @

Edit Run Process > Redirection > Advanced > Performance & Offline

Custom ID submit I\

Label * Submit New Requesf® localhost:8080/jw/web/userview/purchaseRequisition/purchaseRequisitic ~ tion=assignmentView&activityld=
Process * Purchase Request PRUSIIE@ R0V 1N

Run process without %

confirmation screen?
com

Show in popup dialog?

Submit Button Label

pst

# Home > Submit New Request
PURCHASE REQUEST PROCESS - SUBMIT REQUEST

Request Details

Name
Request Date * MM/DD/YYYY
Category Stationery
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Add Inbox Into Userview

* Add Inbox into Purchase Requisition category.

* Configure it to show All Assignments.
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Preview Userview

(Published)

SETTINGS PREVIEW

B Form Purchase Requisition Portal

PURCHASE REQUISITION PORTAL

nme HTML Page

",:: Admin Admin )
G l nbox X#*¥ ian.edryan@gmail.com N
Apps and Workflow Made Simple
) Welcome
& Link
Burttzse Reisiion A Build apps, not just processes!
E LISt Submit New Request = \~ Create full-fledged apps with support for data records management
Inbox
P Run Process Increased Efficiency and Productivity
Faster and more consistent completion of manual processes, and with minimal errors
&a Universal Inbox
B Lowered Cost
Employees can be guided through complex procedures, hence reducing the cost of training
® <
&, User Profile

Powered by Joget
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@Joget
Publish the App

* With the Userview created, it is now ready for prime time.

* End users can now access them through this interface
when the App is made published.

Note: Only ONE App version can be made published at any point of time.
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@ Joget

Publish the App

 Click on Version/Publish button, select the version to publish.

1 JOGET DX ENTERPRISE

APP CONFIGURATION MANAGEMENT

[# Design App:
Purchase Requisition Q Manage App Version Delegate App Designer Role Git Configuration

Not Published -
VERSION PUBLISHED NOTES DATE CREATED
Create New Form I I
1

06-12-2019 03:37
AM
[# Forms & Ul FORMS

i= Processes

B 1-Submit Request
& Properties & Export B 2-Approve / Rejec

B 3-Acknowledge Af

15 v M < Paget of1 > M & Displaying 1to 1 0of 1items
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Launching the Published App

* Click on Launch under Userview pane.

1 JOGET DX ENTERPRISE #A Home &Inbox & Profile (@dmin) @ Logout @ @

[# Design App:
Purchase Requisition

Q @ Show Tags £ Refresh

Create New Form Create New Datalist Create New Userview
# Forms & U FORMS LISTS

USERVIEW
= Processes

B 1-Submit Request . purchase_requests B Request List
© Properties & Export B 2-Approve / Reject Request 5 purc

Purchase Requisition Portal

B 3-Acknowledge Approved _ purchase_req

uests

@ Performance

‘B Logs

G All Apps
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Launching the Published App

* One can also access it through the App Center itself.

—
S

@ l 1 | ) o APFICENTER ) ¢ Admin Admin -
joget|px # 4% 4

Al Decision Customer Employee
Sample Relationship Services Portal
Al Decision Sample Cistomer Employee Portal

| |
— (7>
%— \lg/
e d
Expenses Internal Joget DX
Claims App Service Showcase
Expenses Claim fitemal Service DX Showcase

i

Purchase
Requisition

Purchase Requisition

Powered by Joget q




@Joget
Exercise: Run Through the Process

* With the Userview created, run through the entire Purchase
Request Process again by using ONLY the Userview.

PURCHASE REQUISITION PORTAL

,;:: Admin Admin o # Home > Purchase Requisition > Submit New Request
ian.edryan@gmail.com

PURCHASE REQUEST PROCESS - SUBMIT REQUEST

Welcome
Purchase Requisition e Request Details
I Submit New Request I Name |
Inbox
Request Date * MM/DD/YYYY
Category Stationery
Iltems
Name Quantity
Click to edit Click to edit
Add Row
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@Joget
Exercise: Run Through the Process

e Submit the form (which is part of the Process’s activity flow)
and continue on with the next assignment by going to Inbox.

PURCHASE REQUEST PROCESS - SUBMIT REQUEST

Request Details

Name |

Request Date * MM/DD/YYYY

Category Stationery

Items
Name Quantity ‘
Click to edit Click to edit

Add Row

Remark
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@Joget
Exercise: Integrate DataList Into Userview

e Add a List element into the Userview to incorporate the Datalist
that was created earlier.

e Name it as “List All”".
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@Joget
Exercise: Add CRUD Functionality

e Add a “CRUD” element into the Userview.

* Configure the CRUD to use the list created earlier and
point to the appropriate form for editing.
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@Joget
Exercise: Change Userview Theme

e At Userview Builder’s settings, change the Userview
Theme to a new look and feel.

* Remember to click “OK” after selecting a new theme.

* Preview.
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@Joget
Exercise: App Thumbnail

Notice that other apps have each its own app thumbnail in
the app center? Try to personalize yours too.

-v

@\
joget|Dx_\’ -

S

. Y
;.‘&‘\:1. -
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Chapter Review

We have learnt to:

1.
2.
3.

Create Userview.

Use Userview as application Front-end interface.

Integrate Datalist, Run Process, Inbox into Userview.
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Chapter 3

Introduction to PWA



Requirements

Your mobile phone/device with PWA-supported
browsers.

For PWA to work, it requires Joget to have a secure web
connection (HTTPS).

The theme used in the Joget App is PWA compliant

(By default: DX Progressive Theme & DX X-Admin Theme
are PWA compliant).

35



Adding to Home Screen

e Using your smartphone

or browser, head over to :
https:
m/jw.

e Addto Home Screen.

training.beta.joget.co

e An App will appear on
app launcher.

® Signin as one of the
users (This is so that
Joget would know who to
push the notification to).

15530 @@ - A=l 81%

') @ training.betajogetcom (29

= /2 JoGETDX

% o -

- et

7%, Faster, Simpler Di
A E"j},]&f&.]'rpsformati-on

Test PWA Offline

@ Add Joget DX to Home screen X

11 O <

15557 90O @ -

Add to Home screen

Test PWA Offline

training.beta.joget.com

Cancel

36


https://training.beta.joget.com/jw
https://training.beta.joget.com/jw

Push Notification

e Enable Push Notification in the app itself.
[# Design App: Add Environment Variable : Add Message

Test PWA Offline 7 X )
Set Plugin Default Properties m

Version 1 | Published

ient Variable Resources Plugin Default Properties
JOGET DX ENTERPRISE # Home & Inbox

B

[# Forms & Ul X
Search 7 SET PLUGIN DEFAULT PROPERTIES
i= Processes - g

Test P
Filter by Type Audit Trail

& Properties & Export v PLUGIN N

o Profile (admin) @ Logout

Search
= Formj
@ Performance i Procer | PLUGIN NAME PLUGIN DESCRIPTION PLUGIN VI T\
|
® Logs gty FormData Aud&VTrail Store audit trail of Form Data to 5.0.0 Al
app_form_data_audit_trail table.
G Process Data Collector Save process data into app_report_* tables 5.0.0 Al
All Apps for reporting purposes
PP @ Perfor
I User Notification 5.0.0 AI
‘R Logs
O a

i

S/



@Joget
Push Notification

e Starts a new process instance and make sure that it assigns to
the person who has signed in on the other device/browser.

“~ (& & training.beta.joget.com/jw/web/userview/testPwaOffline/v/_jre.. ® sr (@ [= = 0 :
= TEST PWA OFFLINE aH =_.j.

# Home > RequestApproval Process > Submit Request

REQUEST APPROVAL PROCESS

Section
Name Test approval where approver is cat who is logged in on phone on the right]
Option O Option A O Option B
P——
ibm) N

38



@Joget
Push Notification

e Once process is started and assignment is assigned to the person
signed in on the mobile device, push notification will be sent.

< C & training.beta.joget.com/jw/web/userview/testPwaOffline/v/ jre.. ®

=  TEST PWAOFFLINE

# Home > Request Approval Process Submit Request

PROCESS STARTED

Process started successfully ini j
ocess started successfully & Chrome - training.beta.joget.com + Just now A

New Task: Approval

SITE SETTINGS

& Chrome - training.beta joget.com

Test PWA O.. @
ded to Hom y

Y Settings - Charging via USB VvV

39



@Joget
Offline Support

e Offline storage support allows uninterrupted work when
device is offline.

« Compatibility depends on the theme and userview
menu, down to the form and form field level.

40



@Joget
How To Enable PWA Offline Support

e |n Userview Builder, toggle “Enable Cache for Offline
Support” in each menu element.

DESIGN USERVIEW SETTINGS PREVIEW SAVE o L] CRok o At Toune

B Form Test PWA Offline

wme HTML Page

Performance & Offline

#date EEE, d MMM yyyy# Edit CRUD > UI (List) > Actions (List) > Ul (Add) > Actions (Add) > Ul (Edit) > Actions (Edit) > Advanced > Performance & Offline

& Inbox Menu +)
Cache Settings
& pink # Home
B List
Welcome Scope @
P Run Process
& Universal Inbox ~ z Duration (s) @
=Manage Request @)@ O)(%)
&, User Profile
Manage Request PWA Offline Settings
CRUD
B i Request Approval Process
g Calendar Enable cache for offline support v
Inbox
Lt bt Cache list actions (Non post action) @
Submit Request
Dashboard
Cache all datalist links in first page @

(-1

Datalist Inby
Q holal>l nox Powered by Joget
5

§ Import Menu
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Where Are The PWA Settings?

In Userview Builder > Settings > PWA Supported themes >
Progressive Web App (PWA) Settings,

e USERVIEW BUILDER Test Pwa Offiine v1: Test PWA Offline (Published)
DESIGN USERVIEW ' SETTINGS PREVIEW

Progressive Web App (PWA) Settings

Configure Layout > Configure Progressive Theme > Advanced > Progressive Web App (PWA) Settings > Login Page Ul > Configure Permission

Disable Progressive Web App (PWA)
Support

Disable Web Push Notifications

Additional URLs to Cache @

42



PWA Offline Compatibility

e Compatibility check inside Userview Builder’s Tree Viewer.

USERVIEW BUILDER Test PwA Offline v1: Test PWA Offline (Published)
DESIGN USERVIEW SETTINGS

PREVIEW SAVE *D Undo | C' Redo

/ Advanced Tools

B Form e
ADVANCED TOOLS
wmme HTML Page ‘
&5 Tree Viewer Permission i Usages 0E (18N 24 Diff Checker <[> JSON Definition
& Inbox —_—
Menu
& Link There are plugins not compatible with PWA Offline support. ; Collapse All Expand All Generate Image
. # Hor
B3 List L Z s
[E]- & Userview (Test PWA Offline) G
P Run Process Wel(. Properties
| E Category (<i class="fa fa-home'></i> Home e
& Universal Inbox = gory { )
& Properties
=+ User Profile EMan HTML Page (Welcome) o
| Category (<i class="fa fa-tasks'></i>Manage Request) e
eun CRLIN

: CRUD (Manage Request) o

E| &) Category (<i class="fa fa-users'></i> Request Approval Process) o
Properties
Datalist Inbox (Inbox) 6
& Run Process (Submit Request) o
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@Joget
Exercise: Try Out PWA Offline Support

e On your PC, go to https://training.beta.joget.com/jw
e C(Click on Test PWA Offline App > Manage Request
e Try saving submit a request or save data

TEST PWA OFFLINE

Admin Admin o # Home > Manage Request

aadrian@)joget.org

Welcome

Manage Request o
() NAME OPTION

¥ Request Approval Process (+]
Nothing found to display.
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https://training.beta.joget.com/jw

@Joget
Exercise: Try Out PWA Offline Support

e Enable offline mode by making use of Developer Tools in your
browser

1
o

TEST PWA OFFLINE

»
)

Admin Admin o # Home > Manage Request

aadrian@joget.org

Welcome 10 W

Manage Request o
O NAME OPTION

ﬁ Request Approval Process [ +]
D John Smith Option A Edit

One item found.

CSV | Excel | XML | PDF

| 32 Processes &% Properties | 2% Users @ Monitor £ Settings & Quick Edit : Off 0 o IR D atasource Active: 0, lale: 1
[w ﬂ Elements Console  Sources Ne W i ance  Memory ApSliaake ecurity  Audits 0747 @ X ;
® © V¥ Q | O Preservelog [ Disable cache T ¥ o |
Name Method Status Domain Type Initiator Size Time Waterfall A !

45



@Joget
Exercise: Try Out PWA Offline Support

e Try again - saving submit a request or save data.

e You will be presented with this screen on submission.

e You can click on the Wifi icon on the bottom right anytime to
view stored offline data.

TEST PWA OFFLINE

»
I

Admin Admin o # Home > Offline

aadrian@joget.org

You are currently offline
Welcome Your submitted form data are stored tewg

orarily, and will be submitted again when you are online.

Manage Request o

USERVIEW APP ID FORM NAME USERNAME STATUS DATE SUBMITTED

Test PWA Offline > Manage Request

Pending 21/1/2020 5:54 pm delete
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@Joget

Exercise: Try out PWA Offline support

Get back online.
Joget will now attempt to sync all the data saved to server onli

TEST PWA OFFLINE

Admin Admin @

aadrian@joget.org

Welcome

Manage Reguest o

¥ Request Approval Process (+]

# Home > Offline

You are currently offline
Your submitted form data are stored temporarily, and will be submitted again when you are online.

ID USERVIEW APP ID FORM NAME USERNAME STATUS DATE SUBMITTED

1 testPwaOffline Test PWA Offline > Manage Request admin Pending 21/1/2020 5:54 pm delete

«Go Back

| [# Forms & Ul Z Processes 8 Properties Bre 3 onitor % Settings | & Quick Edit - n® WOy Used: 408 / 588 MB; Datasource Active: 0, Idie: 3
(v E] Elements Console Sources Slow 36 Application Security Audits
® © ¥ Q [ Preservelog [ Disable cachef]v  Offline + 3 ]
Name Add... Status Domain Type Initiator Size Time Waterfall A
__| favicon_uv.ico?m=testconnection&t=1579600449702 (failed) training.beta.j... xhr progressive.min.js:32 0B 8 ms

ne.
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Chapter Review

We have learnt to:

1. Add app to homescreen on mobile.
2. Push Notification.
3. Offline Support.
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Module Review

1. Introduction to Userview Builder
2. Designing Your First Userview
3.

Introduction to PWA
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Recommended Further Learning

e Hash Variables

e Permission Control
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Stay Connected With Joget

www.joget.org
community.joget.org
twitter.com/jogetworkflow
facebook.com/jogetworkflow
youtube.com/jogetworkflow
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